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Chapter 1 - Getting Started 

Welcome to Drive Navigator 
Welcome to KeoSoft Drive Navigator, an easy to use configuration and 
documentation tool for digital adjustable speed drives! 

Drive Navigator is a PC-based software tool that, together with separately 
selected dive product databases, provides a user-friendly graphical 
interface to thousands of sophisticated parameters incorporated into 
microprocessor-based (digital) adjustable speed drives.  The drive 
parameters are presented in an intuitive block diagram format that enables 
the user to quickly visualize how the drive parameters combine to affect 
the operation of the drive. 

Presently available drive databases include: 
• Siemens 6RA24, SIMOREG DC Drive 

• Siemens 6RA70, SIMOREG DC MASTER Drive 

• Siemens 6SE70, MASTERDRIVES (CUVC) Vector Controlled AC Drive 

• Siemens 6SE70, MASTERDRIVES (CUMC) Motion Controlled AC Drive 

With Drive Navigator you can download parameters directly from your 
drives or import existing configuration files including Simovis, Drive 
Monitor, and PCin.  The ease of downloading and uploading drive 
configurations reduces the time required to update the drive parameters as 
well as the time needed to configure custom applications.  With Drive 
Navigator it is easy to produce professional documentation of your drives 
in A, B, C, or D sizes. 
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System Requirements 
To run Drive Navigator you must meet the following minimum hardware 
and software requirements: 

- Pentium II 233 MHz or higher processor 
- Microsoft Windows 98/NT/2000 
- 64 MB of RAM (128 MB recommended) 
- 150 MB of available hard drive space 
- A CD-ROM disk drive 
- VGA or higher-resolution color display 

(minimum SVGA 800 x 600 recommended) 
- Mouse and keyboard 
- Internet Explorer 

 

Installation Instructions 
Note: Be sure to close all other applications before installing this software. 

1. Insert the CD into your CD-ROM drive.  The CD has an autoplay 
feature that will automatically start the installation process.  If, for 
some reason, this feature does not work on your machine, you will 
need to run the setup program (SETUP.EXE) to begin the installation 
process. 

2. Follow the instructions on your screen. 

Starting Drive Navigator 
1. Click the Start button in the lower-right corner of your screen. 

2. Select Programs and then find the Program Group Name used when 
Drive Navigator was installed (the default name is Drive Navigator). 

You can also create a shortcut to Drive Navigator, and double-click the 
shortcut. 
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Obtaining an Authorization Code 
Quad Plus Inc. will generate the authorization code for the software once 
the following information is provided: 
 

• The Software Serial Number.  This number is located on the 
product packaging, the CD jewel case, and the inside front cover 
of the software manual. 

 
• The Site Code.  This 18-character code is listed on the Drive 

Navigator splash screen.  To display the splash screen, run Drive 
Navigator and select the About Navigator… menu item from the 
Help menu. 

 
• The User Information requested below.  Alternatively, Drive 

Navigator can generate a faxable form containing this 
information—just click on the Authorize button located on the 
splash screen, complete the electronic form, and then click on the 
Print button. 

This information can be transmitted to Quad Plus Inc using any of the 
following methods:   

Phone: (815) 740-0860 

Fax:  (815) 740-0864 

Email: support@keosoft.com 

An authorization code will be provided once this information is received. 

Authorizing Drive Navigator 
1. Open the Drive Navigator splash screen. Click on the Authorize 

button followed by the Enter Authorization button. 

2. Click on the Enter Authorization button on the Authorization screen. 

3. Enter your authorization code in the space provided.  The 
authorization code is NOT case sensitive.  As the authorization code is 
typed, the cursor will automatically move to next box as needed.  Note 
that only numbers and the letters ’A’ to ’F’ are used, so ’0’ is always 
zero (not the letter ’O’) and ’1’ is always one (not the letter ’I’). 

4. Once the authorization code is typed click on the Enter button. 
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If the authorization code is incorrect, an error message such as "Site 
Key Not Valid – Possible Mistype" will be displayed.  Check the 
authorization code for accuracy and correct any mistakes.  If the 
authorization code continues to generate errors, contact Product 
Support for assistance. 

5. Once the authorization code is accepted, the splash screen will appear 
will appear with the license information listed beneath the site code.  
Click on the OK button to begin using Drive Navigator. 

To display the splash screen, run Drive Navigator and select the About 
Navigator… menu item from the Help menu. 

 

 

Important: Using Norton Speed Disk to de-fragment your 
hard disk will damage the authorization code files.  The 
effected files are drivenav.rst, drivenav.ent, drivenav.41s, 
and drivenav.key.  To prevent this, configure Norton Speed 
Disk so that it does not move these files. 

 

Demonstration Mode 
When Drive Navigator is initially installed, a 60-day demonstration license 
will be generated by default.  This demo license contains all the features of 
the licensed version, with the exception of printing, saving, and 
downloading to a drive.  You can, however, upload drive configurations 
from the drive and view them in the Drive Navigator graphical format. 

The demonstration license is granted only once per computer. All future 
installations of the software on a particular computer will not generate a 
new demonstration license.  

Technical Support 
For assistance with the installation and configuration of Drive Navigator, 
please call KeoSoft Technical Support at (815) 740-0860.  For best service, 
please be at the computer with the Drive Navigator software. 
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Feedback 
Comments or suggestions of possible improvements to the software and/or 
manual are appreciated and may be sent to the following addresses: 

 
Phone: 

815-740-0860 
 
Fax: 
 815-740-0864 
 
Email: 
 support@keosoft.com 
 
Standard Mail: 

Quad Plus, Inc. 
PO Box 186  
New Lenox, IL 60451 
Attn:  Keosoft Support 
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Chapter 2 - Introduction 

Overview 
Drive Navigator presents the configuration of a drive in an intuitive block 
diagram format.  This provides the user with a much broader understanding 
of the drive configuration than can be obtained from only a list of 
parameters and their values.  The block diagram is composed of: 

• Function Blocks 
• Connectors 
• Binectors (DC MASTER and MASTERDRIVE) 
• Binary Input Functions (SIMOREG 6RA24 Only) 
• Binary Output Functions (SIMOREG 6RA24 Only) 
• Parameters 
• Terminal Blocks 
 

Function Blocks 

Most of the available drive functions, especially the open- and closed-loop 
control structures, are represented by function blocks.  These blocks can be 
grouped together by their relationship to one another, with the relationships 
shown by lines connecting the various blocks.  By grouping and 
connecting the blocks you can view the drive configuration similar to a 
circuit diagram for an analog circuit. 

In addition to the function blocks for basic drive functions, such as the 
speed controller, there are also several general purpose function blocks 
such as adders, multipliers, inverters, and so on, that can be freely 
configured to create custom functions.  The free configurability of the 
function blocks provides an easily way to implement custom functions for 
special applications. 
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Connectors 

The connectors represent the points on the block diagram where the 
internal virtual connection between blocks is made.  All of the signals that 
are available as digital values in memory are available as connectors.  The 
signals that can be represented by connectors are analogous to the 
measurement points of an analog circuit.  Each connector is identified by a 
unique connector number--“Kxxxx” for single words and “KKxxxx” for 
double words. 

Binectors (DC MASTER and MASTERDRIVE) 

All binary functions (inputs and outputs) are designated as binectors.  Each 
binector is identified by a unique binector number, “Bxxxx”. 

Binary Input Functions (SIMOREG 6RA24) 

Binary input functions are special switch inputs that are either on or off.  In 
this way they are similar to input control bits.  Each binary input function 
is identified by a unique number, “BIFxx”. 

Binary Output Functions (SIMOREG 6RA24) 

Binary output functions indicate the status of a binary switch.  They are 
similar to output status bits and can be assigned to one of the four output 
terminals.  Each binary output function is identified by a unique number, 
“BOFxx”. 
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Parameters 

Parameters are the settings that define the drive configuration.  All drive 
controller adjustments, configuration settings, and measurements are 
performed by setting the appropriate parameter values. 

In the block diagram representation, the parameters tell the function blocks 
where to get their values: from a connector (Kxxxx), from a binector 
(Bxxxx), from a binary input function (BIFxx), from a binary output 
function (BOFxx), or from a fixed value.  Each parameter is identified by a 
unique parameter number: 

 SIMOREG 6RA24 DC MASTER and MASTERDRIVES

Read Only Pxxx.x rxxx.x or nxxx.x 

Read Write Pxxx.x Pxxx.x or Uxxx.x 

 

Terminal Blocks 

The terminal blocks are the real-world physical connections and 
correspond directly to the low voltage control terminals available on the 
drive itself.  Each of the control terminals is identified by a unique terminal 
number: 

SIMOREG 6RA24 DC MASTER and MASTERDRIVES

TB1.1 to TB1.26 X101.1 to X101.12 

TB2.27 to TB2.52 X102.13 to X102.22 

TB3.53 to TB3.70 X103.23 to X103.30 
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What is a Project? 
The block diagrams for a collection of drives are grouped into a unit 
referred to as a Project.  The drive collection can be multiple drives of the 
same type (i.e. – all 6RA24 DC drives) or a mixture of drives (i.e. – some 
6RA24 and some 6SE70).  It is denoted by a file folder icon at the top level 
of the Project Explorer. 

The Project Reference Sheet is common to the entire project and serves as 
a cover sheet for the project documentation.  It contains basic information 
about the project such as the project details, end-user/company 
information, and supplier information, as well as a list of all the drawings 
contained in the project.  Some of the data on this sheet are maintained 
automatically, while other data can be modified by selecting the Project 
menu item from the Definitions menu on the Menu Bar. 

The project consists of several “sheets” of documentation, many of which 
are unique to each drive in the project.  Reference Sheets (Rxx) are 
common to the entire project and serve as cover sheets for the project 
documentation.  They contain basic information about the project such as 
project configuration details, end-user/company information, and supplier 
information, as well as a list of all the drawings contained in the project. 

Configuration Sheets are unique to each drive and serve as a summary of 
the drive configuration.  Some of the information displayed on these sheets 
includes motor information, Binary I/O definitions and Analog I/O 
definitions. 

Engineering Sheets are also unique to each drive and contain the block 
diagram drawings that provide a graphical view of the drive configuration. 

To view a sheet, simply click on the desired sheet listed in the Project 
Explorer.  The corresponding sheet details will be loaded in the 
Configuration Editor.  The information of each sheet is editable to various 
degrees, depending on the sheet type. 
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Application Environment 
The Drive Navigator interface consists of a main window divided into 
several sections.  This main window is known as the Application Window 
and is the workspace in which the drive configuration is viewed and edited.  
It consists of a Menu Bar, a Toolbar, a Status Bar, a Project Explorer, a 
Block List, Configuration Editor, and a Parameter Editor. 

 

Menu Bar 

The Menu Bar resides at the top of the application window and lists the 
commands available for use in Drive Navigator.  In addition to the 
standard File, Edit, View, Tools, and Help menus, additional menus 
specific to Drive Navigator are included.  The Menu bar is visible any time 
the application is open.  The following sections describe the menu items in 
detail. 
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File Menu Functions 

These menu items provide project and file system functionality. 

UF Uile  UNUew Project…  

Select this command to start a new project.  The currently open project will 
be closed with the option to save changes, and the New Project window 
will appear. 

UF Uile  UOUpen… 

Select this command to open an existing project.  The currently open 
project will be closed with the option to save changes, and the Open 
Project window will appear.  Use this window to locate and open the file 
of interest. 

UF Uile  UCUlose 

Select this command to close the current project.  The currently open 
project will be closed with the option to save changes. 

UF Uile  US Uave 

Select this command to save the project with the existing project name.  

UF Uile  Save UAUs… 

Select this command to save the project with a new name or in a new 
location.  The Save As window will appear when this option is selected. 

UF Uile  Save As Template…  

Select this command to save one of the drives in the current project as a 
drive template.  Drive templates represent a library of applications that can 
be used to create new drives in projects.  

Refer to HTUSaving the Drive as a Template UTH on page 52 for more information. 
U
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F Uile  Export Drawings…  

Select this command to save the project diagrams as a set of DXF files.  
The DXF format is supported by most CAD programs including 
AutoCAD.  

Refer to HTUExport to DXF File (AutoCAD)UTH on page 61 for more information. 

UF Uile  Add UDUrive… 

Select this command to add a new drive from a template.  The list of 
templates includes default applications provided by KeoSoft and any 
templates created by the user.   

Refer to HTUAdding a DriveUTH on page 50 for more information. 

UF Uile  Import Drives…  

Select this command to add a new drive and import parameters from a 
separate PCin, Simovis, or Drive Navigator file.   

Refer to HTUImporting a DriveUTH on page 50 for more information.  

UF Uile  Page Setup… 

Select this command to view the Page Setup window.  This window 
contains settings for the logo used in the title block and the sheet size of 
the project.   

Refer to HTUPage SetupUTH on page 62 for more information. 

UF Uile  UP Urint… 

Select this command to print the project diagrams.  Several printing 
options are available.   

Refer to HTUPrint OptionsUTH on page 63 for more information. 
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UF Uile  Recent projects 

This section of the File menu displays a list of the four most recently 
accessed project files.  Select any project from this list to open it. 

UF Uile  EUxUit 

Select this command to close the current project and exit Drive Navigator.  
If any unsaved changes exist in the current project, an opportunity will be 
provided to save them. 

 

Edit Menu Functions  

These menu items provide a set of project editing commands. 

UEUdit  CuUt 

UEUdit  UCUopy 

UEUdit  UPUaste 

Select these commands to perform cut, copy, and paste operations.  Blocks, 
lines, and text can be copied/moved to a different drive or to a different 
sheet of the same drive. 

Refer to HTUCut / Copy / PasteUTH on page 59 for more information. 

UEUdit  Edit Parameters… 

Select this command to open the Parameter Edit window.  This window 
displays all the parameters in the current drive and provides a way to edit 
parameter values.   

Refer to HTUEditing ParametersUTH on page 55 for more information. 

UEUdit  Insert New Sheet 

Select this command to insert a blank Engineering Sheet immediately in 
front of the currently selected sheet.  Existing Engineering Sheets are 
renumbered accordingly. 
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UEUdit  Remove Sheet 

Select this command to permanently remove the currently selected 
Engineering Sheet.  Existing Engineering Sheets are renumbered 
accordingly. 

UEUdit  Remove Drive 

Select this command to permanently remove the currently selected drive 
from the project.  

 

View Menu Functions  

These menu items change how the project is displayed.  

UVUiew  Parameter Sets 

The parameters in the drives are grouped into different parameter sets.  The 
number and type of these groups depends on the type of drive, and include 
the following: 

 Parameter Data Sets (PDS) 
 Function Data Sets (FDS) 
 Motor Data Sets (MDS) 
 BICO Data Sets (BDS) 

Use this menu item to select the desired parameter set(s) for the current 
editing session.  A checkmark is placed in the menu beside the active 
parameter set. 

UVUiew  UBUlock List 

Select this command to toggle the visibility of the Block List window.  This 
window lists all the blocks available to the current drive.  A checkmark is 
placed beside this menu item when the Block List window is visible. 

Refer to HTUBlock ListUTH on page 54 for more information. 
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UVUiew  UPUroject Explorer 

Select this command to toggle the visibility of the Project Explorer 
window.  This window provides a hierarchical view of the current project 
and is used to select the sheet displayed in the Configuration Editor.  A 
checkmark is placed beside this menu item when the Project Explorer 
window is visible. 

Refer to HTUProject ExplorerUTH on page 28 for more information. 

UVUiew  USUtatus Bar 

Select this command to toggle the visibility of the Status Bar.  A 
checkmark is placed beside this menu item when the Status Bar window is 
visible. 

Refer to HTUStatus BarUTH on page 28 for more information. 

UVUiew  UTUoolbar 

Select this command to toggle the visibility of the Toolbar.  A checkmark 
is placed beside this menu item when the Toolbar is visible. 

Refer to HTUToolbarUTH on page 23 for more information. 

UVUiew  Zoom In 

Select this command to increase the viewing scale to the next higher 
setting.  The zoom settings are Fit, 50%, 75%, 100%, 150%, and 200%.  
When this command is selected, the Configuration Editor window will 
center on any selected objects when zooming.  If no objects are selected, 
then the Configuration Editor window will center on the middle of the 
screen. 
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UVUiew  Zoom Out 

Select this command to decrease the viewing scale to the next lower 
setting.  The zoom settings are 200%, 150%, 100%, 75%, 50%, and Fit.  
When this command is selected, the Configuration Editor window will 
center on any selected objects when zooming.  If no objects are selected, 
then the Configuration Editor window will center on the middle of the 
screen. 

UVUiew  Fit In Window 

Selection of this command sets the magnification to a value that allows the 
entire drawing to fit in the Configuration Editor window. 

 

Definitions Menu Functions  

These menu items provide access to various Definition windows. These 
windows provide a simplified interface to certain functions in the drive.   
The list of available screens and their contents depend on the currently 
selected drive in the Project Explorer window. 

UDUefinitions  Project 

Select this command to open the Project Definition window.  This window 
provides fields for Project Information, Supplier Information, and End 
User / OEM Information.  This information is displayed on the Reference 
Sheet (Rxx). 

UDUefinitions  Base Drive Setup 

Select this command to open the Base Drive Setup window.  This window 
provides fields relating to Controller and Motor Information.  Some of this 
information is displayed on the Controller Sheets (xCx), while other 
information is used to determine the values of some parameters. 
U
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DUefinitions  Base Drive I/O Setup 

Select this command to open the Base Drive I/O Setup window.  This 
window provides fields relating to the Analog and Binary Inputs and 
Outputs.  Some of this information is displayed on the Controller Sheets 
(xCx), while other information is used to determine the values of some 
parameters. 

UDUefinitions  Base Drive Com Setup 

Drive Dependant Windows 

Select this command to edit drive communication functions.  The windows 
listed in the Base Drive Com Setup menu depend on the currently selected 
drive, and may include fields for serial ports, CB/TB, SCB, and/or 
SIMOLINK communication. 

 

Communication Menu Functions  

UCUommunication  US Uetup… 

UCUommunication  UU Upload (Read)  UAUll Parameters 

UCUommunication  UU Upload (Read)  Changes Only 

UCUommunication  UD Uownload (Write)  Write to URUAM 

UCUommunication  UD Uownload (Write)  Save to UEUEPROM 

Select these commands to access the communication functions of Drive 
Navigator.   

Refer to HTUSection VII –CommunicationsUTH on page 65 for more information.  

Please note that the SIMOREG 6RA24 drive does not have the capability 
of uploading changes only (menu item will be disabled when active drive 
is of this type). 
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Tools Menu Functions  

These menu items provide a set of Configuration Editor tools. 

UTUools  Select Tool 

The Select Tool (arrow) is the most commonly used tool.  With it, you can 
select specific sheets to view, position objects in the Configuration Editor 
window, and so on.  Selected objects are denoted with a red box 
surrounding the object, or the object itself may turn red (such as a selected 
line, for example).  Multiple objects can be selected by drawing a dashed 
box around them with the Select Tool. 

If the SHIFT key is pressed while selecting objects (individually or in 
groups), any new objects are added to the currently selected group.  

Refer to HTUSelecting ObjectsUTH on page 59 for more information. 

UTUools  Line Tool 

The Line Tool (crosshairs) is used to connect two blocks together.  To 
draw a line, click on an Output of a Function (a RED BOX will appear 
while hovering over the edge of the block indicating the correct spot) and 
drag the line to the Input of the target Function (another RED BOX will 
appear indicating the correct spot).  Clicking while dragging the line will 
insert an anchor in the line, allowing line direction to change by 90 
degrees. 

Refer to HTUConnecting LinesUTH on page 57 for more information. 

UTUools  Text Tool 

The Text Tool (I-beam) is used to insert comments into the Configuration 
Editor window.  Simply click on the sheet displayed in the window, then 
type the desired text.  Clicking on existing text with this tool will allow the 
text to be modified. 

UTUools  Zoom Tool 

The Zoom Tool (magnifying glass) is used to magnify the Configuration 
Editor window. Use the tool to draw a BOX around a group of objects, and 
the window will zoom to scale that displays only the selected objects.  The 
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highest zoom factor available is 200%.  If the area selected by the BOX 
would require a greater magnification, the window will be displayed at 
200% centered on the middle of the BOX.  

Tools  Auto Line Reconstruct 

Select this command to toggle the Auto Line Reconstruct feature.  When it 
is on, connecting lines will be redrawn using a standard algorithm after 
blocks are selected or moved. 

This function is especially useful when cleaning up a drawing from a drive 
that was imported from a Simovis or PCin file, or uploaded directly from 
the drive. 

 

Help Menu Functions  

Help  Online Help 

Select this command to display the online manual for Drive Navigator. 

Help  About Navigator 

Select this command to display the Drive Navigator splash screen, which 
contains information about the software revision and authorization.  The 
splash screen is also used to transfer licenses and print registration 
information. 

 

Toolbar 

When enabled, the Toolbar resides near the top of the application window, 
directly below the Menu Bar.  It provides quick access to commonly used 
commands.  Click once on the appropriate button in the Toolbar to carry 
out the action represented by that button.  The Toolbar can be toggled on 
and off by selecting the Toolbar menu item in the View menu.  A 
checkmark is placed beside this menu item when the Toolbar is visible. 

The Toolbar is a dockable toolbar.  This means that it can be attached to 
any of the four sides of the application window by clicking on the toolbar 
handle and dragging it to another location (the toolbar handle is a small 
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vertical line at the left end of the toolbar).  It can also be pulled out of the 
application window and displayed as a separate window. 

The Toolbar contains the following buttons: 

 New Project 

Click this button to start a new project.  The currently open project will be 
closed with the option to save changes, and the New Project window will 
appear. This button performs the same function as the File  New Project 
command on the Menu Bar. 

 Open 

Click this button to open an existing project.  The currently open project 
will be closed with the option to save changes, and the Open Project 
window will appear.  Use this window to locate and open the file of 
interest.  This button performs the same function as the File  New 
command on the Menu Bar. 

 Save 

Click this button to save the project with the existing project name.  This 
button performs the same function as the File  Save command on the 
Menu Bar. 

 Print 

Click this button to print the project diagrams.  Several printing options are 
available.  This button performs the same function as the File  Print 
command on the Menu Bar. 

Refer to HTPrint OptionsTH on page 63 for more information. 

 

 Add Drive 

Click this button to add a new drive from a template.  The list of templates 
includes default applications provided by KeoSoft and any templates 
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created by the user.  This button performs the same function as the File  
Add Drive command on the Menu Bar. 

Refer to HTAdding a DriveTH on page 50 for more information.  

 Cut 

 Copy 

 Paste  

Click these buttons to perform cut, copy, and paste operations.  Blocks, 
lines, and text can be moved/copied to a different drive or to a different 
sheet of the same drive.  These buttons perform the same functions as the 
commands in the Edit menu of the Menu Bar. 

Refer to HTCut / Copy / PasteTH on page 59 for more information. 

 Reconstruct Lines 

Click this button to toggle the Auto Line Reconstruct feature.  When it is 
on, connecting lines will be redrawn using a standard algorithm after 
blocks are selected or moved.  This button performs the same function as 
the Tools  Auto Line Reconstruct command on the Menu Bar. 

 

 Insert New Sheet 

Click this button to insert a blank Engineering Sheet immediately in front 
of the currently selected sheet.  Existing Engineering Sheets are 
renumbered accordingly.  This button performs the same function as the 
Edit  Insert New Sheet command on the Menu Bar. 

 Remove Sheet 

Click this button to permanently remove the currently selected Engineering 
Sheet.  Existing Engineering Sheets are renumbered accordingly.  This 
button performs the same function as the Edit  Remove Sheet command 
on the Menu Bar. 
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 Select Tool 

Click this button to make the Select Tool (arrow) active.  With it, you can 
select specific sheets to view, position objects in the Configuration Editor 
window, and so on.  Selected objects are denoted with a red box 
surrounding the object, or the object itself may turn red (such as a selected 
line, for example).  Multiple objects can be selected by drawing a dashed 
box around them with the Select Tool.   

If the SHIFT key is pressed while selecting objects (individually or in 
groups), any new objects are added to the currently selected group.  This 
button performs the same function as the Tools  Select Tool command on 
the Menu Bar. 

Refer to HTSelecting ObjectsTH on page 59 for more information. 

 Line Tool 

Click this button to make the Line Tool (crosshairs) active.  This tool is 
used to connect two blocks together.  To draw a line, click on an Output of 
a Function (a RED BOX will appear while hovering over the edge of the 
block indicating the correct spot) and drag the line to the Input of the target 
Function (another RED BOX will appear indicating the correct spot).  
Clicking while dragging the line will insert an anchor in the line, allowing 
line direction to change by 90 degrees.  This button performs the same 
function as the Tools  Line Tool command on the Menu Bar. 

Refer to HTConnecting LinesTH on page 57 for more information. 

 Text Tool 

Click this button to make the Text Tool (I-beam) active.  This tool is used 
to insert comments into the Configuration Editor window.  Simply click on 
the sheet displayed in the window, then type the desired text.  Clicking on 
existing text with this tool will allow that text to be modified.  This button 
performs the same function as the Tools  Text Tool command on the 
Menu Bar. 
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 Zoom Window Tool 

Click this button to make the Zoom Tool (magnifying glass) active.  This 
tool is used to magnify the Configuration Editor window. Use the tool to 
draw a BOX around a group of objects, and the window will zoom to scale 
that displays only the selected objects.   

The highest zoom factor available is 200%.  If the area selected by the 
BOX would require a greater magnification, the window will be displayed 
at 200% centered on the middle of the BOX.  This button performs the 
same function as the Tools  Zoom Tool command on the Menu Bar. 

 Zoom in 

Click this button to increase the viewing scale to the next higher setting.  
The zoom settings are Fit, 50%, 75%, 100%, 150%, and 200%.  When this 
command is selected, the Configuration Editor window will center on any 
selected objects when zooming.  If no objects are selected, then the 
Configuration Editor window will center on the middle of the screen.  This 
button performs the same function as the View  Zoom In command on 
the Menu Bar. 

 Zoom out 

Click this button to decrease the viewing scale to the next lower setting.  
The zoom settings are 200%, 150%, 100%, 75%, 50%, and Fit.  When this 
command is selected, the Configuration Editor window will center on any 
selected objects when zooming.  If no objects are selected, then the 
Configuration Editor window will center on the middle of the screen.  This 
button performs the same function as the View  Zoom Out command on 
the Menu Bar. 

 Sheet size 

Click on the arrow to display a list of the available zoom levels.  Select the 
desired magnification to apply it to the sheet that is currently active in the 
Configuration Editor.  A custom magnification between 50% and 200% 
can also be selected by typing the value in the text area of the control. 
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Status Bar 

The Status Bar resides at the bottom of the application window and 
provides information about the current status of the project, including the 
currently selected object name, connector descriptions, and the cursor 
position.  The Status Bar can be enabled and disabled by selecting the 
Status Bar menu item on the View menu.  A checkmark is placed beside 
this menu item when the Status Bar is visible. 

The Help Message Box occupies the left section of the Status Bar.  It 
displays useful information about items in the Menu bar and Toolbar as 
they are selected with the Select Tool. 

The section of the Status Bar to the right of the Help Message Box is the 
Status Message Box.  It is used to display the name of the object (e.g., 
function block or connection) that the Select Tool or Line Tool is currently 
hovering over. 

To the right of the Status Message Box are the boxes for the X Coordinate 
and Y Coordinate of the mouse pointer.  The coordinates are relative to the 
upper left corner of the drawing and are displayed in centimeters. 

 

Project Explorer 

The Project Explorer window occupies the upper-left pane of the 
Application Window by default.  It provides a hierarchical view of the 
entire project and is used to navigate between the different components of 
the project.  Clicking on a component listed in the Project Explorer will 
open a detailed view of it in the Configuration Editor. 

The Toolbar is a dockable window.  This means that it can be attached to 
any of the four sides of the Application Window by clicking on the title bar 
and dragging it to another location (the title bar is the thin box at the top 
containing the text “Project Explorer”).  It can also be pulled out of the 
application window and displayed as a separate window. 
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The project is arranged in the Project Explorer according to the following 
hierarchy: 

 Project Name 
 Reference Sheets 

• Drive Name #1 
 Controller Sheets 
 Engineering Sheets 

• Drive Name #2 
 Controller Sheets 
 Engineering Sheets 

• Drive Name #3… 

 

Project Name 

The top level of the hierarchy is the Project Name.  It can be modified by 
clicking on selecting the Project menu item from the Definitions menu on 
the Menu Bar.  Simply modify the Project Name field and click the OK 
button. 

Immediately below the Project Name is the Reference Sheet (R00), named 
“Project Information and Drawing Contents”. 

 

Reference Sheets (Rxx) 

The Project Reference Sheet is common to the entire project and serves as 
a cover sheet for the project documentation.  It contains basic information 
about the project such as the project details, company information, and 
supplier information, as well as a list of all the drawings contained in the 
project.  Some of the data on this sheet are maintained automatically, while 
other data can be modified by selecting the Project menu item from the 
Definitions menu on the Menu Bar. 

There is initially only one Reference Sheet, R00 in a new project.  As more 
drives are added to the project, additional sheets (R01, R02…) are added to 
provide as needed to provide additional space for their information. 
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Drive Name 

Located under the Project Name are listed each of the drives in the project.  
The top level for each drive is the Drive Name which can be changed by 
Base Drive Setup menu item from the Definitions menu on the Menu Bar.  
Simply modify the Drive Name field and click the OK button.  
Alternatively, clicking on Drive Name in the Project Explorer while it is 
highlighted will open the Drive Name for in-place editing. 

Listed under each of the drives are the Configuration Sheets (xCx) and the 
Engineering Sheets (xEx) associated with that drive. 

 

Configuration Sheets (xCx) 

Each drive in the project has at least one Configuration Sheet.  They serve 
as a summary of the drive configuration and may be edited by using the 
menu items from the Definitions menu on the Menu bar.  Some of the 
information displayed on these sheets includes motor information, Binary 
I/O definitions and Analog I/O definitions. 

The Configuration Sheets are uniquely identified by a three-character 
labeling scheme.  The first character identifies the drive number within the 
project. When the first drive is created, the sheets for that drive are 
designated as 1xx.  If a second drive is added its sheets are designated as 
2xx, and so on.  Drives are numbered sequentially from top to bottom as 
listed in the Project Explorer, and this number may change as drives are 
inserted into and removed from the project.  

The second character, ‘C’, identifies the sheet as a Configuration Sheet, 
while the last character is determined by the number of Configuration 
Sheets for that drive.  For example, the first Configuration Sheet for drive 
1 is labeled 1C1.  The second Configuration Sheet for drive 1 is 1C2, and 
so on. 

Engineering Sheets (xEx) 

The first Engineering Sheet for each drive (sheet xE1) contains a list of all 
the non-defaulted parameters for that particular drive.  The remainder of 
the parameters can be accessed through the objects on the remaining 
Engineering Sheets.  These sheets contain the block diagram drawings that 
provide a graphical view of the drive configuration.  They are primarily 
used to configure and view the parameters of the associated drives. 



   
Chapter 2 - Introduction 

 

 
 

  31 
 

The Engineering Sheets are also uniquely identified by three-character 
labels.  The only difference between the labeling mechanism for these 
sheets and the Configuration Sheets is the second letter, which is an ‘E’ in 
this case. 

These sheets can be renamed by clicking the Engineering Sheet name in 
the Project Explorer while it is highlighted. 

 

Block List 

The Block List occupies the lower-left pane of the Application Window by 
default.  It provides a list of all blocks available in the current drive and is 
organized by category.  Double-click on any of the components listed in 
the Block List to open the Parameter Edit Screen for that particular block. 

The Block List, like the Project Explorer, is also a dockable window.  
Refer to Block List on page 54 for more information. 

 

Configuration Editor 

The Configuration Editor normally occupies the right pane of the 
application window.  It is the main work area and is where the actual 
editing of the drive configuration is performed.   Selecting a sheet in the 
Project Explorer will load the block diagram for that sheet into the 
Configuration Editor. 

 

Parameter Editor 

The Parameter Editor window provides access to view end modify 
parameter values.  It can be accessed by double-clicking a block on an 
Engineering Sheet with the Select Tool or selecting the Edit 
Parameters… menu item from the Edit menu on the Menu bar.  When 
Drive Navigator is online with the drive, changes are written directly to the 
drive instead of the project sheets.   

Refer to Parameters, Editing on page 55 for more information. 
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Title Block Organization 
At the bottom border of every sheet in the project is the Title Block.  The 
Title Block provides key information about the sheet, which varies 
depending on the individual sheet being viewed.  The type of information 
included is detailed in the following sections. 

 
Firmware Revision 

This information is displayed on Engineering and Controller Sheets, and 
may vary between drives.  This information is not applicable on Reference 
Sheets.   

 
Revision History 

This section of the Title Bar provides boxes for up to seven notes that can 
be used to indicate changes to the project or to a particular drive. 

The Revision History boxes on the Reference Sheets indicate changes 
made to the project. 

The Revision History boxes on any of the other sheets indicate changes 
made to the associated drive.  The information in these boxes is the same 
for all sheets associated with a particular drive.  Each drive can have its 
own revision history. 

 
Controller Section 

The Controller Section provides information about the drive controller.  
The information in this box varies depending on the sheet type. 

On Reference Sheets the first line of this section displays the project name.   
The project name is identical for all sheets. 

On all other sheets the first line of this section displays the project name 
followed by the controller name.  The information on this line is the same 
for all sheets associated with a particular drive. 

The second line of information in the Controller Section always displays 
the name of the drawing sheet.  This name can only be changed on 
Engineering Sheets.  The Controller Section on Engineering Sheets also 
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contains a third line that is user definable.  Simply click on the third line to 
add text. 

The upper right corner of the Controller Section displays the Active 
Parameter Set that is documented by this set of drawings.  The Parameter 
Set is changed by selection the Parameter Sets menu item from the View 
menu on the Menu Bar.  The list of available parameter sets depends on the 
type of the currently selected drive.  This information is identical for all 
sheets associated with a particular drive. 

 
Date 

Two boxes are available for date information.  They are identical for all 
sheets. 

 
Engineer 

Two boxes are available for project engineer names.  They are identical for 
all sheets. 

 
Logo  

The logo of the company providing the drawing set is shown and is 
identical for all sheets.   The logo can be set by selecting the Page Setup… 
menu item from the File menu on the Menu Bar. 

 
Drawing Number 

The drawing number can be edited and is identical for all sheets. 

 
Sheet Number 

The Sheet # is generated automatically by Drive Navigator and cannot be 
changed.  The information in this box is unique to each sheet and is 
intended as a suffix to the Drawing Number. 
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Chapter 3 - Designing a New Application 
Example 

 
 

Step #1. – Create Project 

From the File Menu, select 
New Project (Ctrl+N) to 
create a new project.  Select 
B as the sheet size. 

Selecting larger sheet sizes 
depends on your printing 
capabilities.  More blocks 
can be displayed on larger 
sheets, but once scaled to the 
printer’s physical sheet size, 
the blocks maybe too small to read. 

 
Select a Project Template (such as “Blank Project”).  Click on OK to 
create your blank project. 

 
Step #2. – Add a Drive 

From the File Menu, select 
Add Drive (Ctrl+D) to add a 
new drive. 

Select a Drive Template 
(such as “6RA24 Default”).  
If your version of Drive 
Navigator does include the 
6RA24 database, this option 
will not be shown.  Please 
select from one of the 
available drives. 

Click on OK to add the drive to your project. 
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Step #3. – Define the Project 

From the Definitions 
Menu, select Project to 
display the Project 
Definition Template. 

Enter the appropriate data. 

Click OK to update the 
changes to the project 
information. 

This information will be 
displayed on Reference Sheet #R00. 

 
Step #4. – Define Controller and Motor 

From the Definitions 
Menu, select Base Drive 
Setup. 

Enter the name of the 
controller, serial number, 
and other desired 
information. 

Click OK to update the 
changes. 

This information will be 
displayed on the Controller Sheets (xCx) and some parameters will be 
changed. 
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Step #5. – Define Analog and Binary I/O 

From the Definitions Menu, select Base Drive I/O Setup.  Fill in name 
and function information for the Analog I/O. 

Fill in name and function information for the Binary I/O 

Click OK to update the changes. 

 
This Information will be displayed on the Controller Sheets (xCx) and 
some parameters will be changed. 
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Step #6a. – View and Expand the Block List 

From the View Menu, 
select Block List to 
display a list of 
available blocks in the 
drive.  The Block List 
can be dragged and 
docked below the 
Project Explorer. 

 

 
 

Step #6b.  

From the Project 
Explorer, click on 1E7 
– Main Reference and 
Reference Select.  In 
this example we will 
connect the Technology 
Controller to the main 
setpoint of the Setpoint 
Channel. 

Expand the Regulation 
folder in the Block List 
to display all regulation 
functions available to the 6RA24.   
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Step #7. – Add a Function to Sheet 

Click on Technology 
Controller, drag it onto the 
Configuration Editor and 
drop it onto the 
engineering sheet.  

Blocks can only be 
dragged on engineering 
sheets (xEx). 

 

 
Step #8. – Rearrange Blocks  

Rearrange the blocks so 
the Technology Controller 
is above the Main 
Reference block. 

Blocks can be moved by 
clicking (and holding) on 
the block and dragging the 
block to its new location.  
Release the mouse button 
after the block has reached 
its destination. 
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Step #9a. – Making Changes by Parameter 

The drive configuration 
can be changed by 
editing the parameter list 
of the drive or by 
drawing lines between 
blocks.  In this case, a 
connection between the 
Technology Controller 
and the Reference Select 
will be made by setting 
P628.1 = K0220. 

Double click on the 
Technology Controller 
to view the parameters for that block.  Find connector K0220 and double 
click. 

 
Step #9b. 

The parameter P628.1 
can be assigned to the 
output by typing 
“628.1” or by finding 
the connector in the list 
and selecting it. 

Press the ENTER key 
when done. 

Close the parameter edit 
screen. 
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Step #10. – Making Changes by Deleting Lines 

If the mouse cursor is 
placed over the line, 
information about the 
line is displayed in the 
Status Bar at the bottom 
of the screen.  

While this line (and 
only this line) is 
selected, press the 
SHIFT + DELETE key to 
remove the connection 
made. 

If a block (i.e. Technology Controller) is still selected.  Click the mouse in 
an empty space of the Configuration Editor to unselect any objects. 

 
 

Step #11. – Making Changes by Drawing Lines 

 The connection that 
was just deleted can 
also be made by 
drawing a line between 
the blocks. 

Move the cursor over 
the right edge of the line 
for K0220 and a red 
highlight box will 
appear (See Click #1).  
The Status Bar will 
indicate that K0220 is 
selected. 

With a single left mouse click, start the line at K0220.  The Status Bar 
will change to indicate that a line has been started from K0220.  The line 
can be directed around other blocks by single mouse clicks.  Once over 
the connector for P628.1 single click to complete the line draw. 
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Step #12. – Verify Changes 

From the Project 
Explorer, click on 1E1 – 
Parameter List.   

See that the non-default 
parameter list now 
includes the change 
P628.1 = K0220. 

 

 

General Editing Recommendations 

In order to create drawings that are easy to read and understand it is helpful 
to maintain left-to-right signal flow when laying out your design.  That is, 
the object that is the signal source should be to the left of the object that is 
the signal destination wherever practical.  In this way, the signal flow is 
from left to right across the page.  Also, in order to help the reader easily 
locate cross-sheet references it is helpful to extend any stubs to the left and 
right edges of the page, as appropriate. 

It is also advisable to keep related portions of the design together on the 
same sheet whenever possible.   A quick way to move an object from a 
cross-sheet reference onto the current sheet is to double click on the stub 
that designates the cross-sheet reference.  This will automatically pull the 
corresponding block onto the current sheet. 
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Chapter 4 – Documenting an Existing 
Application Example  

 
 

Step #1. – Create Project 
 
From the File Menu, 
select New Project 
(Ctrl+N) to create a 
new project.  Select B 
as the sheet size. 
 
Selecting larger sheet 
sizes depends on your 
printing capabilities.  
More blocks can be 
displayed on larger 
sheets, but once scaled 
to the printer’s physical sheet size, the blocks maybe too small to read. 
 
Select a Project Template (such as “Blank Project”).  Click on OK to 
create your blank project. 
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Step #2. – Import Drive from *.dnl File 
 
The parameter list can be extracted 
from several backup formats 
including PCin Files (*.txt), 
SIMOVIS Files (*.dnl), and Drive 
Navigator Files (*.ksd). 
 
Select the source of the parameter 
list for the drive.  For purposes of 
this example, select the SIMOVIS download file located in the Project 
Files directory.  Typically the file is located at: 
 
C:\Program Files\Drive Navigator\Project Files\6RA24 Example.dnl 
 
Once the SIMOVIS file is selected, a screen is displayed asking for you to 
specify the drive type … in this case, SIMOREG 6RA24. 
 
The parameter list can be extracted from several backup formats (PCin and 
Simovis) or directly from the drive using USS protocol (Serial port).  
During the download, warnings will be noted in the Communication Status 
window.  Some files store read only parameters that Drive Navigator will 
not recognize.  These are merely warnings and do not affect the rest of the 
download. 

 
Step #3. – Define the Project 
 
From the Definitions 
Menu, select Project to 
display the Project 
Definition Template. 
Enter the appropriate 
data. 
 
Click OK to continue. 
 
This information will be 
displayed on Reference 
Sheet #R00. 
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Step #4. – Define Controller and Motor 
 
From the Definitions 
Menu, select Base 
Drive Setup. 
 
Enter the name of the 
controller, the model 
number, serial number, 
and other desired 
information. 
 
Click OK to continue. 
 
This information will be displayed on the Controller Sheets (xCx) and 
some parameters will be changed. 
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Step #5. – Define Analog and Binary I/O 

From the Definitions Menu, select Base Drive I/O Setup.  Fill in name 
and function information for the Analog I/O. 

Fill in name and function information for the Binary I/O 

 

Click OK to update the changes. 

 
This Information will be displayed on the Controller Sheets (xCx) and 
some parameters will be changed. 
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Step #6. – View and Expand the Block List 

From the View Menu, 
select Block List to 
display a list of 
available blocks in the 
drive.  The Block List 
can be dragged and 
docked below the 
Project Explorer. 

Items in the Block List 
that are displayed in 
RED include functions 
that are enabled in the 
drive but not yet 
displayed or connected 
in the Block Diagram. 

 

 

 
 

Step #7.  – Insert an Engineering Sheet 

From the Project 
Explorer, click on 1E9 
– Main Feedback 
with the Speed 
Controller. 

From the Edit Menu, 
select Insert New 
Sheet. 

With sheet 1E10 
selected click on the 
name to edit the sheet 
description.  Type 
“Technology Controller” and press RETURN key. 
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Step #8. – Add the Technology Controller  
 
Click on Technology 
Controller (in the Block 
List) and drag the 
function onto the 
Configuration Editor. 
 
Note that Inputs and 
Outputs are shown as line 
stubs with cross-
references. 
 

 
Step #9. – Find a Connector 
 
The stub connecting to 
K0091 does not include a 
sheet number in the 
cross-reference.  This is 
because the block 
attached to K0091 has 
not been placed on a 
sheet. 
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Step #10. – Get Block From Stub 
 
Move the mouse over 
to the line connecting 
P630.1 to K0091.  The 
line is automatically 
selected. 
 
Right mouse click to 
get the context menu.  
From the context 
menu, select Get Block 
From Stub. 

 
The MOP is placed on 
the sheet. 

 



  
Chapter 4 – Documenting an Existing Application Example 

 

 
 

  49 
 

General Editing Recommendations 
 
In order to create drawings that are easy to read and understand it is helpful 
to maintain left-to-right signal flow when laying out your design.  That is, 
the object that is the signal source should be to the left of the object that is 
the signal destination wherever practical.  In this way, the signal flow is 
from left to right across the page.  Also, in order to help the reader easily 
locate cross-sheet references it is helpful to extend any stubs to the left and 
right edges of the page, as appropriate. 
It is also advisable to keep related portions of the design together on the 
same sheet whenever practical.   A quick way to move an object from a 
cross-sheet reference onto the current sheet is to double click on the stub 
that designates the cross-sheet reference.  This will automatically pull the 
corresponding block onto the current sheet. 
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Chapter 5 – Basic Functionality 

Drives 

Adding a Drive 

To add a new drive to the project, select the Add Drive menu item from 
the File to open the New Drive Options window.  A new drive can be 
created from one of the following methods: 

 
• KeoSoft provided applications including defaulted drives. 
• Templates of previously saved files. 
 
When adding a new drive, two options are given to include drive and 
motor parameters that are typically not valid for new applications.   Any 
parameters that are not included when creating a new drive will show up as 
“?” indicating that the value of the parameter is not known.  These 
parameters will not be downloaded to the drive until the current value is 
read from the drive or its value is changed. 
 

Importing a Drive 

To add a new drive to the project, select the Import Drive menu item from 
the File menu to open the Open File window.  Once a file is selected, a 
new drive is created and parameters are imported from the file.  The 
following file formats are supported: 

 
• SIMOVIS (*.dnl) File 
• PCin (*.txt) File 
• Drive Navigator (*.ksd) File 
 

Please note that when a drive is imported from an existing file, all the 
parameters in the file is imported.  This may not be advantageous if the file 
being imported is to be downloaded to another drive.  The parameters in 
these files often include drive and motor parameter values that may not be 
applicable to a new drive if it is not an identical to the original model 
number.  In this case, download the parameters to the new drive and review 
the parameters that are rejected by the drive.  Once you are satisfied with 
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the application downloaded to the drive, simply upload the parameters to 
overwrite the remaining invalid parameters. 
 

Removing a Drive 

To remove a drive from the project, first select the drive you wish to 
remove by clicking on its name in the project Explorer.  Then, select the 
Remove Drive menu item from the Edit menu.  

Note: Caution should be exercised with this command as the drive will 
be removed immediately.  The only recovery will be to exit Drive 
Navigator without saving changes and reopening the project.  However, 
changes made since the last Save command will be lost. 
 

Changing the Drive Name 
 
The drive name is used to distinguish one drive from another in a project.  
There are several ways to change the drive name including: 
 
• Open the Base Drive Setup window from the Definitions Menu.  

Update the name field and click the OK button. 
• Click on the drive name in the Project Explorer.  Once selected, click 

on the drive name again to edit it. 
• Select a Controller (xCx) or Engineering (xEx) sheet , then click on 

the first line of the title block (in the Configuration Editor) to edit the 
drive name from directly on the title block. 
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Saving the Drive as a Template  
 

Select this command to open 
the Save Drive Template 
window to allow you to save 
the current configuration to a 
user defined drive template.  
These templates serve as  a 
library of drive 
configurations from which 
new applications can be 
created. 

Select one of the drives in the 
drive list and fill in the template name and description.  Once filled, the 
template can be saved.  Once saved, the template can be loaded as a new 
drive by selecting the User tab when adding a drive (see below). 
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Engineering Sheets 
 
Only Engineering (xEx) Sheets can be inserted or removed; all other sheets 
are created and destroyed automatically. 
 

Inserting a Sheet 

When this command is executed, a new Engineering Sheet is added at the 
location of the currently selected sheet in the Project Explorer and the 
Engineering sheets are renumbered accordingly. 

 

Removing a Sheet 

When this command is executed, the currently selected Engineering Sheet 
in the Project Explorer is removed and the Engineering sheets are 
renumbered accordingly. 

 

Changing a Sheet Name 

Only Engineering Sheet names can be changed.  There are a few ways to 
change the sheet name, including: 

• Click on the sheet name in the Project Explorer.  Once selected, click 
on the sheet name again to change it 

• While an Engineering Sheet is selected in the Project Explorer, click 
on the second line of the title block to edit the sheet name. 
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Blocks 
 
A block represents a subset of parameters in the drive used to perform a 
particular function.  Blocks are shown graphically in the Configuration 
Editor and can be edited by double-clicking on them. 
 

Block List 

The Block List provides a list, organized by category, of all blocks 
available in the currently selected drive.  The following table defines the 
various icons that are used in the Block List: 

 

 Black Text Available:  The block is neither currently used nor 
placed on a sheet. Drag this icon onto an Engineering 
Sheet displayed in the Configuration Editor to place 
this block on that sheet.   

 Green Text Used:  The block is placed on a sheet.   

 Red Text Not Placed:  The block is used but not placed on a 
sheet.  This means the block is connected to another 
block and should therefore be placed on a sheet.  
Drag this icon onto an Engineering Sheet displayed 
in the Configuration Editor to place this block on that 
sheet.  Any connections to this block will be 
reconstructed.   

 Black Text Available/Used Folder:  The following categorized 
list of blocks under this folder is either available or 
used.   

 Red Text Not Placed Folder:  The following categorized list of 
blocks under this folder has at least 1 block that is 
used but not placed on a sheet.   
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Dragging Blocks onto Sheets 

Any block that is available (not already placed on a sheet) may be placed 
on an Engineering Sheet (xEx) by dragging the block from the Block List 
to the sheet.  Once placed on the sheet, the block’s status in the Block List 
will change to indicate that it is now located on a particular sheet. 

 

Editing Parameters 

Parameters can be edited directly using one of the Parameter Edit 
Windows.  There are two ways to access a Parameter Edit Window. 

1. Double-click on a Block in the Configuration Editor or the Block List 
to open Parameters Editor window for that block.  The name of the 
block being edited is shown at the top of the window. 

2. Select the Edit Parameters menu item from the Edit menu on the 
Menu Bar.  The Complete Parameter List window will be displayed. 

The Parameter Editor has several filters from which to restrict the 
parameters shown in the list. 

• Show Parameters:  Parameters are displayed. 
• Show Inputs:  Input type parameters (parameters that connect blocks 

with lines) are displayed. 
• Show Outputs:  Binectors, BIFs, BOFs, and Connectors are displayed.  

This option is not available while online with the drive. 
• Show Active Data Set Only:  Only those parameters that are currently 

active are displayed.  To change the active parameter set, select the 
Parameter Sets menu item from the View menu on the Menu to view 
the available options.  These options depend on the currently selected 
drive type. 

• Ignore Read Only Parameters:  If the Show Parameters option is 
selected, select this option to ignore the read only parameters.  In this 
case, only read/write parameters will be displayed (parameters that can 
be edited). 

• Ignore Defaulted Parameters:  If the Show Parameters option is 
selected, select this option to ignore defaulted parameters.  In this case, 
only the non-default parameters are displayed.  This option is not 
available while online with the drive. 
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Double-click on the read / write parameter you wish to modify.  Read only 
parameters are grayed out and cannot be edited.  Depending on the 
parameter type, Drive Navigator will provide the following information. 

 

Standard Parameter – most 
parameters have a range of 
values from min to max. 

Simply enter the new value 
and press ENTER.  If the value 
is out of range, the value is 
return to the original value. 

Parameter with Index Text – 
some parameters in the drive 
include a descriptive list for 
the meaning of each value. 

Select the new value from 
the list or simply type the 
new value and press ENTER.   

 

Input Parameter – some 
parameters are used to 
connect two points of a 
block(s). 

Select the new value from 
the list or simply type the 
name or connector number of 
the output. 
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Output – can also double-
click on an output to assign a 
parameter to its value. 

Select the new value from 
the list or simple type the 
name or parameter number of 
the input. 

Note: If the parameter is 
assigned to a non-default 
value, the parameter is 
shown in red.  This is used to indicate that the parameter is already 
connected for a different purpose and may not want to be changed. 

 

Note:  On the 6RA24 drive, inputs that are assigned to a value “K0002” are 
always defaulted.  The default value depends in the parameter.  If the input 
is assigned to “K0002”, the Parameter Editor will display the value of the 
parameter followed by the default value (i.e. “K0002 = K0149”). 

 

Lines 

Lines connect an input parameter to an output.  Lines are drawn 
automatically when a block is initially placed on a sheet and will move as 
the block is moved 

 

Connecting Lines 

Input parameters can also be assigned graphically by drawing lines 
between input (parameter) pins and output (binector, BIF, BOF, or 
connector) pins.   
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To start a line on an input or 
output pin, single-click while 
the pin is highlighted by a 
red box.  Since the pin was 
selected, the tool is 
automatically changed to the 
line tool. 

As you move the mouse, two 
lines will be drawn from the 
previous to the next point.  
The longer of the two lines is 
always drawn first.   

The line is completed when 
it is connected to a valid pin 
or line (provided started on 
an input pin).   

To start a line from an existing line, the Line Tool must be selected first.  
In cases where a line is started from an existing line, it can only be 
completed by selecting a valid input pin (otherwise two outputs would be 
connected together).      

It is sometimes necessary to drop a line that has been started but is no 
longer needed.  Press the ESC key to drop a line. 

Deleting Lines 

To delete a line or line segment click on the line or segment with select 
tool.  The line will be highlighted in red.  Press SHIFT + DELETE to delete 
the line.   
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Basic Utilities 

Selecting Objects 

Click on any function block to select it. A red highlight box is drawn 
around the selected object.  To select multiple objects, hold down the SHIFT 
key while clicking on additional objects.  Alternatively, the Select Tool on 
the Toolbar can be used to draw a selection area around several objects on 
the Configuration Editor. 
 

Moving Objects 

To move an object, first select it and then drag it with the mouse.  For finer 
control, use the ARROW keys to move it a step at a time.  To move in 
larger steps, hold down the SHIFT key while pressing the ARROW key. 

Note: While a block is being moved, some of the detail is turned off to 
allow for faster program response.  It is turned back on when the 
block is re-selected. 

To move objects between drawing sheets use the cut/copy/paste operations. 
 

Removing Objects 

To remove an object from a sheet, select the object(s) and press the DELETE 
key.  The objects can include text, blocks, and lines.  Any blocks that are 
removed from the sheet will show up in the Block List as not used.  If lines 
are selected and SHIFT + DELETE is pressed, the input parameter is set to 
0 to delete the connection.  This effectively removes the block from the 
sheet and disconnects it from any other blocks. 
 

Cut / Copy / Paste 

The cut operation is used to remove the currently selected objects from the 
sheet and place them in a paste buffer (clipboard).  Once placed in the 
clipboard these objects can be pasted to any drive.  If the blocks are pasted 
on a drive that already has these blocks placed on a sheet, then the blocks 
will be moved to the new location. 
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The copy operation is used to copy the currently selected objects into the 
paste buffer (clipboard).  Once placed in the clipboard these objects can be 
pasted to any drive.  Again, if the blocks are pasted on a drive that already 
has these blocks placed on a sheet, then the blocks will be moved to the 
new location. 

Cleaning up the Drawing 

In the course of moving blocks and making connections, the lines can 
become scrambled and difficult to read.  Drive Navigator provides a 
reconstruct function that is very helpful for cleaning up the drawing to 
make it more readable. The reconstruct command unscrambles the lines 
and reroutes them cleanly between their source and destination(s).  It can 
be applied to a single line, to all of the lines connected to a particular 
block, or to all lines connected to a group of blocks. 

You can also use the Reconstruct Lines button on the Toolbar to enable 
automatic reconstruct during editing.  If the Reconstruct Lines mode is 
enabled (button pressed) all of the lines connected to a block will be 
reconstructed any time the block is moved.  If a group of blocks is selected, 
all of the lines connected to all of the blocks will be reconstructed. 
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Export to DXF File (AutoCAD)  

Sheets can be exported to a DXF 
file format. This format is supported 
by most CAD programs, including 
AutoCAD. 
 
Select the folder to save the 
exported files.  Drive Navigator 
automatically names the files using 
the drawing set and sheet numbers. 
 
Selected sheets or the entire project 
can be exported.  The specific pages 
are identified similarly to the print 
setup screen.  Sheets can be 
specified by their sheet number 
(R00, 1C1, 2E3, etc) or by their 
position in the drawing set (1,2,3…). 
 
R00 Print the first reference sheet, R00 
R* Print all reference sheets, R00, R01, … 
1C2 Print second controller sheet for the first drive, 1C2 
1C* Print all controller sheets for the first drive, 1C1, 1C2, … 
C* Print all controller sheets, 1C1, 1C2, …, 2C1, 2C2, … 
1E2 Print second engineering sheet for the first drive, 1E2 
1E* Print all engineering sheets for the first drive, 1E1, 1E2, … 
E* Print all engineering sheets, 1E1, 1E2, …, 2E1, 2E2, … 
1C1-1E6 Print sheet range from 1C1 to 1E6 
5-4E4 Print sheet range from fifth sheet to 4E4 
 
Any of the above selections can be combined into the same export 
sequence by using commas.  Please note that if a sheet is referenced twice 
(i.e. R00,R*), the sheet will be exported only once. 
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Chapter 6 – Printing Projects 

Page Setup 
 
To change these settings, 
click on File on the Menu 
Bar and select Page 
Setup.  From this screen 
the page size and the title 
block logo can be 
changed. 
 

 

Changing Sheet Size  
Selecting the correct sheet size depends on your printer capabilities.  More 
blocks can be placed on larger sheets, but once scaled to the printer’s 
physical sheet size, the blocks maybe too small to read. 

If the sheet size is decreased in size, any blocks located on the sheets will 
automatically be repositioned to fit the smaller sheet area.  If the sheet size 
is increased, a checkbox is provided to choose whether to reposition the 
blocks. 

 

Changing Title Block Logo 
The default logo for the title block displays the KeoSoft logo. The logo 
setting is an application-wide setting; if you choose an alternate logo by 
selecting the Page Setup… menu item from the File menu on the Menu 
Bar, the new logo file will be displayed on all projects loaded or created 
by Drive Navigator.  If the alternate file name is blank or the selected file 
is no longer available, Drive Navigator will revert to the KeoSoft logo.  
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Print Options 
 

Drive Navigator 
provides several 
convenient options 
for printing reports 
to document your 
project.  Reports 
can be generated for 
individual drawing 
sheets, individual 
drives, or a 
complete project.   

To open the print 
dialog, click on File 

 Print on the Menu Bar.  From this screen, you can then select a 
printer, set the paper size and orientation, and make any other changes as 
needed. 

Before printing documentation verify that the printer is configured 
correctly.  To access the printer setup, click on Properties on the print 
screen. The software will display the Printer Properties dialog box.  
From the Printer Properties dialog box, the printer size and orientation 
(typically landscape) can be changed.   

Once the printer is setup, you may select to print the entire project, 
specific sheets, or sheet groups.  All sheets can be specified by their sheet 
number (R00, 1C1, 2E3, etc) or by their position in the drawing set 
(1,2,3…).  
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R00 Print the first reference sheet, R00 
R* Print all reference sheets, R00, R01, … 
1C2 Print second controller sheet for the first drive, 1C2 
1C* Print all controller sheets for the first drive, 1C1, 1C2, … 
C* Print all controller sheets, 1C1, 1C2, …, 2C1, 2C2, … 
1E2 Print second engineering sheet for the first drive, 1E2 
1E* Print all engineering sheets for the first drive, 1E1, 1E2, … 
E* Print all engineering sheets, 1E1, 1E2, …, 2E1, 2E2, … 
1C1-1E6 Print sheet range from 1C1 to 1E6 
5-4E4 Print sheet range from fifth sheet to 4E4 
 
Any of the above selections can be combined into the same print job by 
using commas.  Please note that if a sheet is referenced twice (i.e. R00,R*), 
the sheet will be printed only once. 
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Chapter 7 - Communications 
 
Communication Setup 
 
 
This selection provides the setup 
window for USS Protocol 
communications.  In this window, 
you may specify the following: 

 
Slave Address For USS Protocol, each drive should have its own slave 

address number 0 to 31. 
Com Port Identifies the COM Port number that the drive is 

connected to.  Because of the slave address limitation, 
each COM Port can accommodate up to 32 drives. 

Baud Rate The Baud Rate is the speed at which data is transmitted 
and received through the COM Port.  If the drive does 
not communicate, it is usually because the baud rate is 
not the same as the drive. 

Number of PZD As part of USS Protocol, the drive will tack on status 
and control words at the end of all transfers.  This 
setting should reflect the drive settings. 

Monitor If checked, a monitor window will be used to display 
transfers.  This is useful when tracking communication 
problems while online with the drive or performing 
upload/downloads. 

Test This function is useful to verify that the current settings 
are correct. 

Ok New communications settings are recorded. 
Cancel New communications settings are ignored. 
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Upload  

An upload function will get the current values of parameters of the drive 
and record them in Drive Navigator.   

If upload changes only is selected, only those parameters in the drive and 
the software that are listed as non-defaulted are read from the drive.  This 
significantly reduces the time to read the parameters out of the drive.   

If upload all parameters is selected, then all read/write parameters are read 
from the drive.  Also included are any read only parameters that record the 
drive’s configuration or firmware. 

 

Download  

A download function will get the current values of parameters of Drive 
Navigator and write them the drive. 

If download RAM is selected, the values are written to the drive’s volatile 
memory.  This means that the values of the parameters are lost when the 
drive looses power. 

If download EEPROM is selected, the values are written to the drive’s 
nonvolatile memory.  This means that the values of the parameter are 
retained even after the power is lost.  Be aware that there is a limit to the 
number of times a parameter value can be written to EEPROM.  Check the 
drive manual for details. 
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Communicate with 6RA24 Drive 

RS232 Connection (X501) Port 1

9 Pin D Connector (Male)

1

2

3

4

5

6

7

8

9

Connect to X501 on Drive

1

2

3

4

5

6

7

8

9

9 Pin D Connector (Female)
Serial Port on Computer

12345

6789

RS485 Port on Computer

9 Pin D Connector (Male)
Connect to X500 on Drive

with RS485
Other Drives

(optional)

Tx / Rx +
Tx / Rx -
GND

RS485 Connection (X500) Port 0

 

The RS232 cable used to upload and download parameters is NOT a 
standard serial cable and is NOT the same as the cable used to 
communicate with the DC MASTER or MASTERDRIVES.  Other cables 
may have very similar pin out to the one shown above, but includes 
additional connections that may cause the drive port not to work. 



 
Chapter 7 – Communications 
 

 
68 
   

6RA24 Communication Settings 
 
If you are unable to communicate with the drive, compare the 
communication settings with the following parameter values.  Some of the 
parameters correspond to the fields in the communication setup window.  

 
X501 – RS232 X500 – RS485 Value(s) 
P790 P780 Protocol = 1192 (Recommend) 
P791 P781 Number of PZD = 2 (Typical) 
P793 P783 Baud Rate (*) 
  1: 300 Baud 
  2: 600 Baud 
  3: 1200 Baud 
  4:  2400 Baud 
  5: 4800 Baud 
  6: 9600 Baud 
  7: 19200 Baud 
  8: 38400 Baud (Recommend) 
  9: 93750 Baud 
  10: 187500 Baud 
P796 P786 Slave Address = 0 (Typical) 
 
(*) If P793 is changed, P790 must also be changed or power cycled in the 

drive in order for the baud rate of the X501 port to change. 
 If P783 is changed, P780 must also be changed or power cycled in the 

drive in order for the baud rate of the X500 port to change. 
 
In the SIMOREG 6RA24 drive, the only way to change these parameters 
in the drive is through the function keypad on the drive.  If you are to make 
any changes to these parameters make sure P51 = 20 and P52 = 3. 
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Get Access to the Drive Parameters (P51) 

The function key selects 
between the parameter 
name and its current 
value.  With a Pxxx 
viewed in the display, 
use the Up / Down 
Arrow keys to select P051.  Select the function key to view its current 
value.   

Use the Up / Down 
Arrow keys to change 
the value to 20. 

Note: While holding one 
of the Arrow keys, if the function key is also pressed, the drive will cycle 
through its values at a faster rate. 

 

X500X501
RS485 PortRS232 Port

Function Up / Down

X500X501
RS485 PortRS232 Port

Function Up / Down

Start Serial Upload / Download 

For the 6RA24 drive, the only upload option available is to upload all 
parameters.   
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Communicate with 6RA70 Drive 
 
Note: The 6RA70 Drive has up to three USS communications ports.  
SCom1 is connected through a 9-pin D connector, X300.  SCom2 is 
connected through a 5-position terminal, X172 on the controller board 
CUD1.  SCom3 is connected through a 5-position terminal, X162 on the 
optional controller board CUD2. 
 
RS232 Connection (X300) USS1 Interface

9 Pin D Connector (Male)

1

2

3

4

5

6

7

8

9

Connect to X300 on Drive

1

2

3

4

5

6

7

8

9

9 Pin D Connector (Female)
Serial Port on Computer

Optional - Used by 6SE70-CUMC
Compact PLUS Drive

 
 
The RS232 cable used to upload and download parameters is NOT a 
standard serial cable and is NOT the same as the cable used to 
communicate with the 6RA24 drive.  Other cables may have very similar 
pin out to the one shown above, but includes additional connections that 
may cause the drive port not to work. 
 

12345

6789

RS485 Port on Computer

9 Pin D Connector (Male)
Connect to X300 on Drive

with RS485
Other Drives

(optional)

Tx / Rx +
Tx / Rx -
GND

RS485 Connection (X300) USS1 Interface
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RS485 Port on Computer

5 Position Terminal
Connect to X172 on Drive (CUD1)

with RS485
Other Drives

(optional)

Tx / Rx +
Tx / Rx -
GND

RS485 Connection (X172) USS2 Interface

56 57 58 59 60

 
 
 

RS485 Port on Computer

5 Position Terminal
Connect to X162 on Drive (CUD2)

with RS485
Other Drives

(optional)

Tx / Rx +
Tx / Rx -
GND

RS485 Connection (X162) USS3 Interface

61 62 63 64 65
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6RA70 Communication Settings 
If you are unable to communicate with the drive, compare the 
communication settings with the following parameter values.  Some of the 
parameters correspond to the fields in the communication setup window. 
 
X300-USS1 X172–USS2 X162–USS3 Value(s) 
P780 P790 P800 Protocol = 2 (Recommend) 
P781 P791 P801 Number of PZD = 2 

 (Typical) 
P783 P793 P803 Baud Rate 
   1: 300 Baud 
   2: 600 Baud 
   3: 1200 Baud 
   4:  2400 Baud 
   5: 4800 Baud 
   6: 9600 Baud 
   7: 19200 Baud 
   8: 38400 Baud  

(Recommend) 
   9: 56700 Baud 
   11: 93750 Baud 
   13: 187500 Baud 
P786 P796 P806 Slave Address = 0 

 (Typical) 
 
 

6RA70 Parameterization Enable (Write Access) 
If you are able to read from the drive but get error when try to write a 
parameter value, verify that the Parameterization Enable (P927) is set 
properly.  
  
X300-USS1 X172–USS2 X162–USS3 
P927 = xxxx x1xx P927 = xx1x xxxx P927 = x1xx xxxx 
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Communicate with 6SE70-CUVC Drive 
 
Note: The 6SE70-CUVC Drive has two USS communications ports.  
SCom1 is connected through a 9-pin D connector, X300.  SCom2 is 
connected through a 12-position terminal, X101. 
 

RS232 Connection (X300) SCom1

9 Pin D Connector (Male)

1

2

3

4

5

6

7

8

9

Connect to X300 on Drive

1

2

3

4

5

6

7

8

9

9 Pin D Connector (Female)
Serial Port on Computer

Optional - Used by 6SE70-CUMC
Compact PLUS Drive

 
 
The RS232 cable used to upload and download parameters is NOT a 
standard serial cable and is NOT the same as the cable used to 
communicate with the 6RA24 drive.  Other cables may have very similar 
pin out to the one shown above, but includes additional connections that 
may cause the drive port not to work. 
 

12345

6789

RS485 Port on Computer

9 Pin D Connector (Male)
Connect to X300 on Drive

with RS485
Other Drives

(optional)

Tx / Rx +
Tx / Rx -
GND

RS485 Connection (X300) SCom1
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RS485 Port on Computer

12 Position Terminal
Connect to X101 on Drive

with RS485
Other Drives

(optional)

Tx / Rx +
Tx / Rx -
GND

RS485 Connection (X101) SCom2

1 2 3 4 5 6 7 8 9 10 11 12

 
 

6SE70-CUVC Communication Settings 
 

If you are unable to communicate with the drive, compare the 
communication settings with the following parameter values.  Some of the 
parameters correspond to the fields in the communication setup window. 

 
X300 – SCom1 X101 – SCom2 Value(s) 
P700.1 P700.2 Slave Address = 0 (Typical) 
P701.1 P701.2 Baud Rate 
  1: 300 Baud 
  2: 600 Baud 
  3: 1200 Baud 
  4:  2400 Baud 
  5: 4800 Baud 
  6: 9600 Baud 
  7: 19200 Baud 
  8: 38400 Baud (Recommend) 
  9+ For SCB Only 
P703.1 P703.2 Number of PZD = 2 (Typical) 
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If you are able to read from the drive but get error when try to write a 
parameter value, verify that the Parameter Access (P053) is set properly.   
 

6SE70-CUVC Parameter (Write) Access 
 
X300 – SCom1 X101 – SCom2 
P053 = xxxx xxxx xxxx x1xx P053 = xxxx xxxx xx1x xxxx 
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Communicate with 6SE70-CUMC Drive (Compact 
PLUS) 
 
Note: The Compact PLUS drive has only one USS communications port 
(SCom1) that can be connected to a 9-pin D connector, X103, or to a 4-
position terminal, X100. 
 

RS232 Connection (X103) SCom1

9 Pin D Connector (Male)

1

2

3

4

5

6

7

8

9

Connect to X103 on Drive

1

2

3

4

5

6

7

8

9

9 Pin D Connector (Female)
Serial Port on Computer

 
 
The RS232 cable used to upload and download parameters is NOT a 
standard serial cable and is NOT the same as the cable used to 
communicate with the 6RA24 drive.  Other cables may have very similar 
pin out to the one shown above, but includes additional connections that 
may cause the drive port not to work. 
 
WARNING: RS232 and RS485 cannot be used at the same time on the 
SCom1 port.  This is true even when the X103 is connected as RS232 and 
X100 is connected as RS485.  When the RS232 cable is used, any 
communication through the X100 port is disabled. 
 

12345

6789

RS485 Port on Computer

9 Pin D Connector (Male)
Connect to X103 on Drive

with RS485
Other Drives

(optional)

Tx / Rx +
Tx / Rx -
GND

RS485 Connection (X103) SCom1
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RS485 Port on Computer

4 Position Terminal
Connect to X100 on Drive

with RS485
Other Drives

(optional)

Tx / Rx +
Tx / Rx -
GND

RS485 Connection (X100) SCom1

36 35 34 33

 
 

6SE70-CUMC Communication Settings 
(Compact PLUS) 

If you are unable to communicate with the drive, compare the 
communication settings with the following parameter values.  Some of the 
parameters correspond to the fields in the communication setup window.  
 
X100 or X103 - SCom1 Value(s) 
P700.1 Slave Address = 0 (Typical) 
P701.1 Baud Rate 
 1: 300 Baud 
 2: 600 Baud 
 3: 1200 Baud 
 4:  2400 Baud 
 5: 4800 Baud 
 6: 9600 Baud 
 7: 19200 Baud 
 8: 38400 Baud (Recommend) 
 9+ For SCB Only 
P703.1 Number of PZD = 2 (Typical) 
 
If you are able to read from the drive but get error when try to write a 
parameter value, verify that the Parameter Access (P053) is set properly.   
 

P053 = xxxx xxxx xxxx x1xx 
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Communicate with 6SE70-CUMC Drive (Compact / 
Chassis) 
 
Note: The Compact and Chassis drive has two USS communications ports. 
SCom1 is connected through a 9-pin D connector, X300, or through a 6-
position terminal, X103.  SCom2 is also connected through the 6-position 
terminal, X103 (different terminals). 
 

RS232 Connection (X300) SCom1

9 Pin D Connector (Male)

1

2

3

4

5

6

7

8

9

Connect to X300 on Drive

1

2

3

4

5

6

7

8

9

9 Pin D Connector (Female)
Serial Port on Computer

Optional - Used by 6SE70-CUMC
Compact PLUS Drive

 
 
The RS232 cable used to upload and download parameters is NOT a 
standard serial cable and is NOT the same as the cable used to 
communicate with the 6RA24 drive.  Other cables may have very similar 
pin out to the one shown above, but includes additional connections that 
may cause the drive port not to work. 
 

12345

6789

RS485 Port on Computer

9 Pin D Connector (Male)
Connect to X300 on Drive

with RS485
Other Drives

(optional)

Tx / Rx +
Tx / Rx -
GND

RS485 Connection (X300) SCom1
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RS485 Port on Computer

6 Position Terminal
Connect to X103 on Drive

with RS485
Other Drives

(optional)

Tx / Rx +
Tx / Rx -
GND

RS485 Connection (X103) SCom1

25 26 27 2823 24

 
 
Both communication ports are available on terminal X103.  Each port is 
connected to different terminals on X103. 
 

RS485 Port on Computer

6 Position Terminal
Connect to X103 on Drive

with RS485
Other Drives

(optional)

Tx / Rx +
Tx / Rx -
GND

RS485 Connection (X103) SCom2

25 26 27 2823 24
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6SE70-CUMC Communication Settings 
(Compact / Chassis) 

If you are unable to communicate with the drive, compare the 
communication settings with the following parameter values.  Some of the 
parameters correspond to the fields in the communication setup window. 
 
X300 or X103 - 
SCom1 

X103 – SCom2 Value(s) 

P700.1 P700.2 Slave Address = 0 (Typical) 
P701.1 P701.2 Baud Rate 
  1: 300 Baud 
  2: 600 Baud 
  3: 1200 Baud 
  4:  2400 Baud 
  5: 4800 Baud 
  6: 9600 Baud 
  7: 19200 Baud 
  8: 38400 Baud (Recommend) 
  9+ For SCB Only 
P703.1 P703.2 Number of PZD = 2 (Typical) 
 

6SE70-CUMC Parameter (Write) Access 
(Compact / Chassis) 

If you are able to read from the drive but get error when try to write a 
parameter value, verify that the Parameter Access (P053) is set properly.   
 
X300 or X103– SCom1 X103 – SCom2 
P053 = xxxx xxxx xxxx x1xx P053 = xxxx xxxx xx1x xxxx 
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Chapter 8 – Moving Authorizations 
 

Every time Drive Navigator is installed on a computer, the software 
generates a Site Code specific to that software installation.  KeoSoft must 
provide an authorization number, which unlocks the features of the 
software. 

The following features are protected: 
• Save current work that can be read later 
• Download parameters to the drive using the serial port 
• Print the project 
• 6RA24 Library 
• 6RA70 Library 
• 6SE70-CUVC Library 
• 6SE70-CUMC Library 

For more information about the authorization process, see HTAuthorizing 
Drive NavigatorTH 
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The authorization number is, of course, only good for one installation of 
the program.  Once authorized, the “license” can be moved from one 
computer to another provided a demo version of the software is loaded on 
the other machine.  To move the license to another computer, click on the 
About Navigator… menu item from the Help menu, then follow the 
instructions on the splash screen. 

 Computer 
w/ Original Installation 

Computer 
w/ New Installation 

Current State Drive Navigator is a 
licensed version. 

Drive Navigator is in demo 
mode or is unlicensed. 

Step #1. 
 
Select Get License on the 
computer with the new 
installation.  Follow the 
instructions. 
 

  
 
Authorization request is placed 
on a diskette or shared drive. 
 

Step #2. 
 
Select Move License on the 
computer with the original 
installation.  Follow the 
instructions. 
 

 
 
Authorization is moved to 
the requested location.  
This computer’s site code 
is now changed. 

 

Step #3. 
 
Compete operation started in 
step #1 on the computer with 
the new installation. 

  
 
The Authorization number is 
accepted by this computer. 

Result Drive Navigator is no 
longer licensed. 

Drive Navigator is a licensed 
version. 
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Appendix A – Documentation Services 
 

KeoSoft can provide documentation services to those individuals who do 
not have the printing capabilities or who do not have the time to document 
their drives. 

KeoSoft can provide color laser printed copies on A-Size and B-Size 
paper.  High quality, color prints can be made on C-Size and D-Size paper 
as well. 

Prints can be made from nothing more than a PCin or Simovis file.  
Therefore, Drive Navigator is not required for KeoSoft to provide these 
documentation services. 

Please call 815-740-0860 and ask about the Keosoft Documentation 
Service. 
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Appendix B – Contact Information 
Technical Support 

For assistance with the installation and configuration of Drive Navigator, 
please call KeoSoft Technical Support at (815) 740-0860.  For best service, 
please be at the computer with the Drive Navigator software. 

Feedback 
Comments or suggestions of possible improvements to the software and/or 
manual are appreciated and may be sent to the following addresses: 

 
Phone: 

815-740-0860 
 
Fax: 
 815-740-0864 
 
Email: 
 support@keosoft.com 
 
Standard Mail: 

Quad Plus, Inc. 
PO Box 186  
New Lenox, IL 60451 
Attn:  Keosoft Support 

 
 



 

 

 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

 
 

 
CHICAGO AREA  
1919 Cherry Hill Road 
Joliet, IL 60433 
Phone:  (815) 740-0860 
Fax:  (815) 740-0864 
 
LOS ANGELES AREA  
30 Hughes, Suite 208 
Irvine, CA 92618 
Phone:  (949) 462-0860 
Fax:  (949) 462-0861 
 
ATLANTA AREA  
2593 Kennesaw Due West Rd. 
Kennesaw, GA 30144 
Phone:  (678) 594-7823 
Fax:  (678) 594-7367 
 
SATELLITE FACILITIES  
• Charlotte, NC - USA 
• Bursa, Turkey 
 
 
VISIT US ON THE WEB AT: 
WWW.QUADPLUSINC.COM 
 
 

OR CALL TOLL FREE: 
(877) 870-QUAD 

 

 Quad Plus, Inc.         
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